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Visio®Visio®Visio®Visio®    Based Model Railroad Based Model Railroad Based Model Railroad Based Model Railroad TTTTrack Planningrack Planningrack Planningrack Planning    

Layout planning or planning modifications has traditionally been a daunting task 

that requires sitting for hours with a pencil, drawing templates and a very large 

eraser. As a software Engineer by profession, it is my natural tendency to look to 

the computer for providing solutions to the design and development of a layout 

track plan. In the pursuit of that perfect layout to fit the available space, there are 

multiple CAD programs that allow for the development in 2D and 3D track plans. 

This tutorial is to present a route that may not have been fully explored to 

designing and laying out a track plan.  

Microsoft®, the very large software company from the Pacific Northwest, has a 2D 

drawing package, called Office Visio® that may be the answer to designing the 

next modification or full track plan for your layout. My journey of track planning 

and development has been the culmination of many years using the standard 

pencil and paper and drawing packages for various layouts. I had a full plan and 

started building the benchwork for an 8 ft. x 14 ft. upstairs storage room.  
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Then fate stepped in and I am currently back in the design phase. This time for a 

new layout that will occupy a 17 ft. x 22 ft. single car garage, which more than 

tripled the available square footage. This re-planning allowed for the addition of 

new large industries in line with recent kit purchases. On the flip side, it increased 

the amount of benchwork, track, wiring, scenery and everything else that a layout 

entails. To accommodate a new layout for the additional space I returned to a  

drawing package that I have used for work: Visio®. I use the Visio® Professional 

version as that is what I have available, but for any version of Visio® the methods 

described in this tutorial are valid.  

Why not one of the train CAD packages? The answer is fairly simple: 1. The need 

is for a computer based 2D drawing package that is with the budget (Through an 

employee purchase program it was only $9 USD). 2. It does not encompass a 

monstrous learning curve to be able to use like most track CAD programs.3. The 

tool is required allow for an accurate (to Scale) drawing of the layout and the 

room the layout will occupy. 4. The tool must be able to be modified to the 

scale/gauge of the track that will be used in the layout.5. And lastly, it must be 

something I have available to me and not a new purchase. 
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Visio® presents a drawing canvas that is capable of being configured to a specific 

architect’s drawing scale. This allows for the 2D drawing to accurately depict the 

real world in a scale representation. For the purposes of this introduction to the 

tool, all dimensions will be in US rather than metric units.  

The section Introduction to Visio® covers learning how to use Visio® starting with 

how to open the application and configure it to match a specific room's 

dimensions for the layout. The tutorial starts with defining how an HO layout will 

be used to fit into a 10 ft. x 10 ft. room using HO Code 100 Snap Track®. 

Once the room organization has been defined, the basic shape of the layout is 

constructed by introducing the drawing functions of Visio®. You will learn how to 

use these operations to build a base layout shape for the tutorial layout. 

Upon completion of building the base shape the real power of Visio® for track 

planning starts to take shape. The tutorial instructs you how to build shape 



4 

 

stencils that are used to quickly drag and drop track, switches and building shapes 

into the layout.  

Terrain, tunnels and rivers are introduced utilizing functions in Visio® allow you to 

build a 2D top down view of these constructs on the layout. 

In addition to laying out the track the tutorial includes instructions on how to take 

the track plan and convert it to a control panel schematic diagram. In addition to 

the schematic, instructions are included on how to represent lamps and toggle 

switches on the schematic diagram. 

A description the benchwork to support the example is presented in a way as to 

allow you to construct L-Girder benchwork.  

Additional chapters include how to generate an inventory of track or buildings 

from the layout plan and how to generate accurate measurements of items on 

the layout. Lastly, I have included 1°, 2° and 3° rise charts for quick reference. 

The tutorial layout will occupy a 10 ft. x 10 ft. room and will be in HO Scale using 

either flex track or Code 100 Snap Track. The methods that are described here will 

work for any gauge, size or shape of room or layout. Additionally, the techniques 

will work for any manufacturer’s track, scale, or products that can be drawn in a 

top-down 2D representation. So let's get started. 

-Eric Smith 

August 2016 
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Introduction to Introduction to Introduction to Introduction to Visio®Visio®Visio®Visio®    
Open the Visio® application from the PC. Visio® will present a screen to allow the 

user to select the type of drawing that is to be used. This selection represents the 

stencils that are standard for the type of drawing to be produced. Since one 

purpose of this write up is to show how to develop a stencil specific for the 

drawing of track plans, the Basic Diagram is where to begin. A Single click on the 

Basic Diagram icon will bring up a selection dialog for either Metric Units or US 

Units. This tutorial will use US measurement units. 

 

The canvas for the basic open screen is for a single page of paper. As items are 

moved outside of this single page, Visio® will add additional pages to the display 

canvas automatically. 
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For this tutorial, a single page is a piece of 8.5” x 11” US letter paper. The 

horizontal and vertical rulers around the drawing canvas represent the size of the 

drawing itself. Along the left side is the shapes and stencils toolbox. The 

Stencil/Shapes toolbox is one of the more powerful capabilities for use in the 

model railroad track planning. The Shapes toolbox allows for a drag and drop 

capability of objects onto the drawing canvas. Simply select one of the objects 

from the toolbox by holding down the left mouse button and drag it from the 

toolbox onto the canvas. This creates an instance of that object into the canvas. 

Repeating this action with other toolbox entries allows for the creation of 

complex diagrams.  

To help with the drawing it is recommended that the “Theme” not be applied to 

any elements drawn in the canvas. This feature defines a default fill color and 

inserts a shadow to the objects created in the drawing canvas. Using the Design 

tab select the “More” theme selection from the themes scroll bars. This is 

represented by a down arrow with a line on top of it. A list of themes that can be 

applied to the drawing will be displayed appended to the bottom of the smaller 
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theme selection toolbox. Uncheck the selection at the bottom of the list for 

“Apply Themes to New Shapes”. All shapes drawn will now use a default outline 

of black and a fill color of white.  

The first step is to put the canvas in a viewing mode appropriate to the physical 

dimensions of the room. For simplicity this tutorial will use a 10 ft. x 10 ft. room. 

To set the canvas size, select the View tab and then Page Setup from the View 

toolbar. This will bring up a dialog box that allow for the definition of drawing 

scale of the canvas by selecting “Drawing Scale” in the “Page Setup” Dialog box. 

Selecting the “Pre-defined scale” radio button will allow for the selection from 2 

pull down selection boxes. The first pull-down selection box is the type of scale 

and the second is the actual scale for the drawing based on the size of the paper.  

In the lower left of the “Page Setup” dialog box is the Page size (in measurement 

units). The page size in measurement units can be modified by changing the scale 

from 3/32” = 1’0” to another value. To appropriately represent the 10 ft. x 10 ft. 

room, a scale of ¾” = 1’0” can be used. This sets the page size to 14 ft. 8 in. x 11 ft. 

4 in. which is enough to represent the room and any walls for the 10 ft. x 10 ft. 

room. Pressing the “OK” button will set these values for the drawing canvas.  
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When the Page Setup Dialog box closes, the canvas rulers along the top and left 

side now represent the drawing scale of the size of the canvas in feet.  

To draw the room, select a square from the shapes tool box and drag it to the 

canvas. This will generate a 2 ft. x 2 ft. square on the canvas centered where the 

mouse is released. By moving the square around before releasing the left mouse 

button, the square can be positioned appropriately close to the top left of the 

drawing. This rectangle represents the “perimeter” of the room, and in the US 

wall studs are 3.5 in. with approx. 0.5 in. of sheetrock. For this tutorial, assume 

that the sheetrock has not been applied, but that the studs are exposed. Adding 

the stud size value, 10 ft. + 3 ½ in. + 3 ½ in., will make the size of the perimeter of 

this rectangle to 10 ft. 7 in x 10 ft. 7 in. To draw the room outline, select the lower 

right small white drag box on the square shape and drag the shape until the size 

(as shown at the bottom of the screen) indicates the box is 10 ft. 7 in. x 10 ft. 7 in.  

The room is drawn by instancing another square from the shapes toolbox and 

sizing it to 10 ft. x 10 ft. Do not worry that the two do not form what looks like a 

room, what is important at this step is to get the shapes in the correct horizontal 

and vertical dimensions.  
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Select the Home tab from the top menu to bring up the “Shape Styles” toolbox 

entry. This selection box contains the options to change the color of the box in 

addition to the line around the outside of the box. It is possible to change the 2
nd

 

created box to match the color of the flooring in the room by selecting this 

option. Press on the small downward pointing triangle next to the “Fill” bucket 

and select a color. A personal preference is to set the color of the first rectangle 

to a brick color or gray to represent the wall. Set the color of the second rectangle 

to a one representative of the carpet or flooring in the room.  

The “Line selection” option in the “Shape Styles” toolbox allows for the changing 

of the outline around the boxes. Set this value to “Black” for delineation between 

the squares. Do this for both squares.  

Currently the two squares representing the room are not aligned correctly. The 

“Arrange” toolbox entry on the Home tab provides a mechanism to remedy this 

situation. Pressing on both of the existing boxes with the left mouse button held 

down allows for the selection of both squares. Note: select the background “wall” 

first then the floor. The order is important as the align tool works relative to the 

first object on the screen selected. Select the “Align” pull down (the downward 

triangle under the word “Align”) so that the squares can be aligned to the center 

and to the middle in successive selections. This is accomplished by selecting 

“Arrange”-“Align”-“Align Center” and then “Arrange”-“Align”-“Align Middle”.  

 All rooms have some sort of egress to the room, a door a window or stairs. For 

this demonstration, assume the room has a door into the room, a closet door 

directly across from the entry door, and a 4 ft. window on the same wall as the 

closet. To draw these items for the room, Visio® already has some pre-defined 

shapes for doors and windows. Select “Search” under the “Shapes” title on the 

left of the canvas above the stencil toolbox. This will bring up a search text entry 

box to allow for the selection of pre-defined stencils. Entering the word “Door” 

and pressing enter will cause Visio® to search and display a list of shapes that are 

in this category.  

The “Walls, Doors and Windows” subtitle contains a door that is The “Walls, 

Doors and Windows” subtitle contains a door that is configurable to meet the 

requirements of the room. Dragging the “Door” icon onto the canvas 

instantiates/creates one door in the drawing. The door comes into the canvas in a 
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“standard configuration of 2 ft. 6 in. in size. With the door 

still selected, press the right mouse button to bring up the 

option to reverse the door from a right opening to a left 

opening. Next drag the door into the lower left corner of the 

room into the gray portion of the wall. Align the door with 

the inside line of the door aligned with the inside of the 

room. The door thickness can be reduced by selecting the 

center white selection box of the door and dragging it up to 

match the size of the wall. If the door is more than 30 in., a 

right mouse click and selecting properties of the door will 

allow for accurate dimensioning of the door opening. The 

process of inserting, reversing the opening and placement of 

the door can be done to put in the closet door on the 

opposite wall.  

A window is represented in the Shapes toolbox as an 

“Opening” from the “Walls, Doors and Windows” subtitle. Just like the door, the 

opening can be adjusted to fit the correct size and placement on the wall.  

 

If the door or window is not on a horizontal wall, but on a vertical wall select the 

door with a left mouse button. A circular arrow will appear above the selected 
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object. This circular arrow, and the line from it to a small circle in the center of the 

shape, represents a rotation mechanism for the object. The circular arrow is used 

to rotate the shape and the small circle is used to represent the center of the 

rotation. Clicking on the circular arrow changes the cursor to represent the 

rotation control of the shape. Holding down the left mouse button and moving 

the mouse left or right will rotate the shape. Rotating very close to the center of 

rotation of the object will increment the rotation in steps of 15⁰. Moving away 

from the center of rotation and moving the mouse left or right will rotate the 

shape in smaller increments starting at 10⁰, next 5⁰, then 1⁰ and finally 0.1⁰. This 

will work for all shapes and groups of shapes in Visio®.  

Congratulations! The room has been set up. So from the File menu or the small 

disk icon above the File menu tab, save the layout plan with the name of “Visio® 

Layout Tutorial”. The next step is draw the basic shape of the layout and to put on 

track. 
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The The The The LLLLayoutayoutayoutayout    ––––    the the the the Basic ShapeBasic ShapeBasic ShapeBasic Shape    
In this tutorial room there are basically 3 walls that can be utilized for the layout. 

The layout is a HO Scale modified figure-8 that travels around the layout covering 

as much of the room as possible. The minimum radius curve is limited to be 15 in. 

in special cases, but 17 in. will be the normal radius. This will restrict how much 

track can be put down and how much space is available in the room for other 

activities, such as a workbench.  

Starting with the underlying layout base, there will be a 2 in. distance from any 

track to the edge or wall. That means that the 34 in. required for a 17 in. radius 

circle now becomes 38 in. Drag a circle from the Basic Shapes stencil on the left of 

the display canvas and size it to 3 ft. 2 in. using the up and down arrows move the 

circle to the wall just under the window, but clear of the closet door until it 

touches the wall. Using the copy and paste, make a copy of the circle and place it 

on the opposite wall next to the entry door.  
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To make the circles align vertically correctly, select both of the circles while 

holding down the shift key on the keyboard. A rectangle will be drawn 

surrounding the selected circles to show the boundaries of the circles. Using the 

“Arrange”-“Align”-“Align Left” command will make sure that the circles are at the 

same position relative to one another on the left side.  

After the circles have been placed and aligned, it is time to start creating what will 

be the layout base for the track plan. Select a rectangle from the Shapes and 

position it approximately at the top center of the top circle. Using the right center 

and the bottom center white selection boxes of the rectangle drag (increase the 

rectangle in size horizontally and vertically) to the right and downward until the 

bottom of the rectangle touches the wall to the right and the bottom of the circle 

to the left. Repeat this rectangle addition for the bottom of the layout.  

Since this is the base layer of the layout it is nice to color it something like grass 

green or a brown for dirt. Use the mechanisms previously described to select a 

color for the objects representing the layout on the screen. In order to 

understand how some of the mechanisms in Visio® work, make the color of the 

circle a different color than the rectangle.  
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Visio® supports the concept of “Operations” on objects that allow for the merging 

or removal of various parts of an object in the canvas. These operations are some 

of the most power tools available for generating up the shapes for a Model 

Railroad layout. Operations can best be thought of as Venn or Set diagrams and 

the possible logical representations of changes to the sets in the diagram. 

 

A union operation on a set is the combination of both of the objects. 

 

The intersection of a set is the point where the objects overlap. 

 

The subtraction of one set is shown by the resulting portion of the set minus the 

point where the two sets intersect and the other set. 
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To utilize the various set manipulation mechanisms, it is easiest if the pull down 

menu for the operations is located on the Home tab. To add this, right mouse 

click in the white area to the right of the existing menu options that contains 

“Style Shapes, Tools, etc.” Select “Customize the Ribbon…” from this pull down 

menu. This displays the Visio® Options for customizing the ribbon. On this 

dialog, select the Main Tabs from the pull down and Open the “Home” menu by 

selecting the small “+” in the box beside the checkbox for Home. This shows the 

list of tool bar options that exist across the “Home” tab on the top of the screen. 

Select the Home in this list. It will have a highlight color to reflect the selection.  

In the left pull down: “Choose commands from:” instead of “Popular 

Commands” select “All Commands”. The entire list of commands available to 

use in Visio® are listed. Scroll down until “Operations” is shown and highlight it 

and then press the “Add>>” button in the middle of the dialog box. Press “OK” 

and the list of Operations is not on the Home menu for selection.  

The Operations menu consists of selections to manipulate multiple objects as 

functions of the Venn diagram modification operations. The two I use are Union 

and Subtract. I rarely use the others if at all and then only “Intersect”. The 

“Union” allows for the merging of multiple objects into a single object. The 

“Subtract” option allows for the removal of one object from another. To see 

these operations, an object must be selected from the canvas. Otherwise the 

menu is grayed out indicating it is not a valid command.  
 

On the “Operations” menu, the Union operation allows for the merging together 

of multiple objects into a single object on the screen. To do this multiple objects 

must be selected concurrently. To select multiple objects, the “Shift” key is used 

in conjunction with a left mouse click. An example of this is to first select one of 



16 

 

the rectangles with a left mouse click. Press and hold the shift key down and 

select the circle that is under the rectangle with another left mouse click. At this 

point both object are “highlighted” with a  border around them and common 

white “selection” boxes.  

The order the objects are selected is important for operation commands, because 

the properties such as color and border color, line thickness, etc. of the first 

selected object will be passed onto the new object. With both of the objects 

selected, use the “Union” Operation from the “Operations” pull down menu. A 

single “Half-Pill” shape will be produced that has the first selected object’s color. 

Repeat this procedure for the other circle and rectangle.  

 

For this layout the normal minimum radius selected is to be limited to 17 in. Using 

this limit, care must be taken to accommodate the curvature from each of the 2 

parts that have already been created. Instantiate/drag a rectangular area that 

connects the top and the bottom pill shapes already created. This is done by 

dragging a rectangle between the other rectangles along the wall. Make this 



17 

 

rectangle 4 ft. wide and if everything was correct with the generation of the other 

rectangles, it will be 3 ft. 8 in. in height. Note that 3 ft. is a little wide for this 

connecting section and it would be nice to generate smooth curves between the 

sections already generated. This can be done by the use of the “Subtract” 

operation.  

To build the concaved curvature between the two half-pill shapes drag a circle 

from the shape in between the two pill shapes and expand its size to exactly 

touch the top and bottom of the two layout halves.  

Slide the circle to the right until the center selection boxes line up with the left 

edge of the 4ft. x 3 ft. 8 in. rectangle using the arrow keys.  

 

De-select the circle and select the underlying rectangle. This is because for the 

subtract operation, the first shape selected gets subsequent shapes subtracted 

from it. Hold down the “Shift” key and select the circle. Using the Operation 

subtract, remove the circle from the rectangle.  
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There are now 3 objects on the screen that should be one, representing the base 

of the layout. This is done by use of the Union command combining the 3 objects 

together. In the same manner as the merging of the original circle and rectangles, 

use the Union command to combine the base layout objects. Once again order is 

important to keep the color of the first select object.  

At this point, a “base” layout structure should appear in the canvas that is 

representative in size (Feet Horizontally x Feet Vertically) of the proposed layout.  

The only problem with this base layout is the curvature at the end of each end of 

the layout. There is a little wasted space in between the layout and the doors to 

the room and the closet. The addition and merging of rectangles that fill this gap 

on each side corrects this problem.  
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This is another one of those good spots in the tutorial to save the layout to the 

disk. Use either the “File” menu or the floppy disk icon above the File menu to 

save the layout plan.  
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LayersLayersLayersLayers    
It is now time to start on planning the track for the layout. However, some 

caution must be takes so as to not disturb what has already been generated. The 

way to do this by the creation of layers representing the various components that 

have been drawn onto the canvas. Select everything in the canvas by pressing 

Control-A. Note: Keep the Layout shape separate by holding the “Shift” key down 

and “de-selecting” the base layout portion of the drawing.  

On the “Home” tab toolbar is the “Editing” menu. In this option is a “Layers” pull 

down. From this menu select “Assign to Layer”. This brings up the “Layer” dialog 

box. Since some of the items place into the drawing already have layer 

definitions, select “None” from the buttons on the right side of the dialog box. 

Next assign the “room” objects (The walls, the doors, window, etc.) to a “New” 

layer designated as “Room”. To do this select the “New” button on the right, 

which will bring up the New Layer Name box. Enter the word “Room”, and select 

“OK”. In the Layer Dialog, a new layer name is now present with the name 

“Room” checked. Select “OK” to close the Layer Dialog.  

Next select the Layout base and repeat the Layer assignment but with a separate 

layer titled “Layout”. 

There are two distinct layers that have been created to represent the room and 

the base layout. These areas need to be protected so that when new items are 

placed onto the canvas these will not be disturbed, and cannot be selected. To 

accomplish this, select the “Layers” dropdown again, but this time select Layer 

Properties. The “Layer Properties” dialog box will be shown with all of the layers 

that were shown from the “Assign to Layer” dialog. In this dialog is the capability 

to make a layer not visible, and to lock it from being selected or changed. Select 

the lock for both the Layout and the Room layers and press “OK”.  

What has been created to this point cannot be selected or modified until it has 

become “unlocked” by reversing the “Lock” in the “Layer Properties”.  

Congratulations! The room and the base layout have been set up.  

Note: Be sure and save often so that changes are not lost.  
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Custom Shapes/StencilsCustom Shapes/StencilsCustom Shapes/StencilsCustom Shapes/Stencils    
With the room and the base layout defined, it is time to start actually putting 

something representing track onto the layout. To do this, it is necessary to define 

a custom stencil that represents different track elements. As part of this tutorial, 

all track will be either flex track (in exact curve radii) or will be Snap Track® for 

HO. The Code 100 track comes in:  

• Straight 

o 9 in. 

o 6 in. 

o 3 in. 

o 2 ½ in. 

o 2 in. 

o 1 ½ in. 

o 1 in. 

o ¾ in. 

• 15 in. Radius 

o ½ 15 in. Radius 

• 18 in. Radius 

o 1/3 18 in. Radius 

o ½ 18 in. Radius 

• 22 in. Radius 

• 24 in. Radius 

• Turnout 

o Left #4 Switch 

o Right #4Switch 

• Track crossings 

o 19⁰ 

o 25⁰ 

o 30⁰ 

o 45⁰ 

o 60⁰ 

o 12  ½⁰ 
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The first step in using the stencils/shapes for the laying out of a track plan is to 

define a stencil specifically for the track scale being developed. One of the fastest 

ways to start this process is to get a predefined scale stencil for Visio®. At the time 

of the writing of this tutorial, very few stencils exist for access from the internet. 

Some do exist, and the best known is a stencil library from LGB for their G Scale 

track. For the purpose of this tutorial, the steps defined will create a new 

stencil/shape library that can be used to accurately represent the track for a 

specific scale. Keep in mind that all of the techniques are appropriate to all track 

manufacturers and track scales.  

In the definition of a new stencil the easiest method is to use a picture as the 

actual object or to use a picture to create the object. A web image search for HO 

Code 100 track will present pictures on that can be used to accomplish this task.. 

If there is access to photo editing software, such as Photoshop it makes this task 

much easier by cropping out any of the image around the actual track that are not 

representative of the track itself. 
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From this image it can be seen that the picture was inserted of a 24 in. Radius 

track picture that is 2 ft. 1 in. in length and height. The radius of the curve is 

measured from the center of the curve which means this piece of track in the 

picture is over twice the size necessary to represent the actual track.  

If it is possible to edit the picture and remove or make transparent, the area 

surrounding the track that is preferred such that only the track is present. 

Through “Insert” tab, a photo of the track can be added to the canvas.  

 

Through experimentation shrinking and rotating the inserted image, relative to a 

24 in. radius circle, it is able to determine that the width of the track image needs 

to be set at 9.4 in. Which matches up to the math of 1/16 of the circumference of 

a 24 in. radius circle. To properly size the image draw a rectangle that is 9.4 in. in 

width. From the “Shape Styles”-“Fill” select “No Fill” for the rectangle. Select the 

image of the track again and using the white selection handle (only on the 

corners) resize the picture such that the track fits exactly inside the size of the 

rectangle. 



24 

 

For Snap Track the follow number of track sections make a complete circle: 

15 in. radius = 12 track sections 

18 in. radius = 12 track sections 

22 in. radius = 16 track sections 

24 in. radius = 16 track sections 

Another option is to build a virtual piece of track by using the subtraction 

operation on a circle representing the track. This is preferred to show larger 

curvatures without having to put each piece of track and aligning them into the 

plan. The way to do this is to draw two circles that represent the outer radius of 

the size of the track and then another representing the inside of the track. For the 

24 in. track, this is 24 ½ in. outer and 23 ½ in. for the inside. After these two 

circles are centered in the alignment, then it is possible to subtract the inner circle 

from the outer circle which will represent a ring of the track including ties.  

This method can be used to represent ½, ¼, and 1/8 of the radius of the curve. To 

create these subtract the rectangles that have been placed appropriately as to 

only leave the desired curvature portion once the subtraction has occurred. To do 

this copy the ring of track and paste it into the canvas. Draw a rectangle that is 

larger than ½ of the size of track.  
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Select the track ring first and then subtract the rectangle 

from the circle. This will leave a half circle of the track. 

Color these partial radii with a medium gray so that they 

will stand out against the layout base background and kind 

of look like ballast. With the half circle selected, just start 

typing the radius of the curve “24”. This will automatically 

start the text entry for the object. To end the text entry 

press the Escape “Esc” key. It is useful to know where the 

center of the circle resides for transferring the track plan 

to the actual layout. This is represented by drawing a line 

from right center to the left center of the half circle. Put an 

arrow on that line using the “Shape Styles”-“Line”-“Arrow” that points from the 

starting/center of the circle to the outer radius of the shape at the center point of 

the curvature.  

To create a ¼ version, copy the ½ circle by the copy and paste method. Next draw 

another rectangle that is larger than ½ of the copied portion of the track circle. 

Select the rotate arrow on this rectangle and rotate it to 45⁰ with an edge of the 

rectangle passing through the center of the circle. Subtract the rectangle from the 

½ circle by the Operation methods previously described. This leaves a track 

representation of 1/8 of 24 in. circle. If the track picture sizing was done 

appropriate, copying and pasting 2 of the track pieces will exactly match up to the 

1/8 curve.  

Five different objects should be on the screen to represent the 24 in. radius track. 

This is the perfect time to create a stencil for the track. From the “Shapes” tool 

box on the left of the canvas select the “More Shapes”. Almost to the bottom of 

this menu is the “New Stencil (US units)” option. Selecting this option will cause a 

new Stencil to be created in the stencils list with a large red Asterisk and the title 

“Drop Quick Shapes here” underneath it. To add the 24 in. curve shapes select 

them from the canvas and drag them one at a time into the stencil area. Each will 

be removed from the canvas and now be present in the Stencil Shape menu 

named with the title “Master” and a numerical value. A right mouse click on the 

new stencil entry will bring up a menu that will allow for the renaming of the 

stencil entity.  
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Rename each shape appropriate to the radius and curvature: 

• 24 in radius 

• ½ 24 in. radius 

• ¼ 24 in. radius 

• 1/8 24 in. radius 

• 24 in. Snap Track 

Right mouse click on the “Stencil Name” will allow for 

the saving of the Stencil to the hard drive for future use. 

Use the “Save As” function and change the name to HO 

Code 100. Now using drag and drop the track shapes can 

be placed onto the layout. Use the “Assign to Layer” 

command to make sure all of the track placed on the 

canvas are in a “Track” group. This makes it easier for 

later processing of the layout. This procedure can be 

used to generate all of the different pieces of Snap Track 

and the curvatures of the track.  

When adding the track shapes to the shape/stencil it is 

recommended to group the different percentages of the curve together. All ½’s 

together, then all ¼’s, but it is possible to group these in any manner any order by 

dragging the shape icon in the shape menu to a different location. 

It is recommended to build these curvatures for radii that increment in 1 in. 

values. This results in being able to represent curvatures using flex track of 

various radii. This is useful since the minimum radius for this layout is 17 in. and 

Snap Track does not exist for this radius of track. 

Note: The concentric circles for a specific radius are 1 in. greater and 1 in. 

smaller than the desired radius of the circle. This takes into account ½ of an inch 

on each side of the radius of the circle. Subtracting the concentric circles 

(selecting the largest circle first) will result in a circle of 1 in. width for the track. 
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NonNonNonNon----Picture Track ShapesPicture Track ShapesPicture Track ShapesPicture Track Shapes    
For the true die hard planners, it is possible to create a shape using the drawing 

tools to replicate the track in the picture. This is done by drawing rectangles for 

each tie and the end pieces of the piece of snap track to generate a non-picture 

representation of the track. For all scales this method can be used to represent 

longer pieces of straight track representing pieces of flex track. For HO use this to 

define at lengths of 18 in., 27 in. and 36 in. straight segments.  

As an example of this technique, import the 9 in. Straight picture from the 

internet into the canvas and rotate it 90⁰ so that the track runs from left to right. 

Draw a rectangle exactly 9 in. in length on top of the picture and set the fill of the 

rectangle to “No Fill”. Select the track package picture and scale it with the corner 

white selection rectangles until the length of the track portion of the picture 

matches the length of the rectangle. It may be necessary to zoom into the canvas 

in order to see this correctly. 

There are two ways to easily zoom into or out of the canvas. The first of these is 

to use the zoom in/out mechanism on the bottom right of the bottom of the 

canvas. Moving the zoom component or pressing the plus symbol (+) or the 

minus symbol (-) will zoom in or out.  

 

The second zoom method, if the mouse has a track wheel, is to use the control-

Mouse wheel mechanism. Holding down the control and rotating the mouse 

wheel forwards will increase the zoom factor. Holding down the control key and 

rotating the mouse wheel backwards will decrease the zoom factor. 

 

Draw a ¼ pt. line width rectangle over one of the ties of the straight piece of 

track. It is possible to draw all of these rectangles representing the ties by hand, 

but Visio® has provided a copy feature that works much faster for this task. Select 

the newly generated tie rectangle, hold down the “Control” key until a small plus 

“+” symbol appears on the cursor. Holding the Shift key down left mouse click on 

the tie and drag it away from the existing tie. This generates a copy of the object 

in the canvas. Use this method to generate 5 ties that are placed over 5 ties on 

one end of the track picture. Deselect the last tie and select all 5 of the ties that 
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have been created. Using the same technique, with the Control and drag, 5 more 

ties can be generated. Repeat this until the appropriate number of ties have been 

created to cover the ties on the picture.  

 

Select all of the ties and align them to the top using the “Align” menu from the 

“Arrange” tool option on the Home tab. To make the ties equally spaced, select 

one end tie first then select all of the ties and use the “Position” menu from the 

“Arrange” tab to “Distribute Horizontally”. Lastly, fill the color of the ties with 

either black or a dark brown.  

Using small rectangles with 1 pt. lines it is possible to generate the tie “caps” on 

each end of the piece of track. For the Snap Track, use 5 small rectangles and 2 

lines to create the end cap. 

Group all 7 of these smaller rectangles together and fill them 

with the same track color. Using the Shift-Drag-Copy method, 

copy this shape. Use the “Position”-“Rotate Shapes”-“Flip 

Horizontal” to create the other end of the track end cap. Use 

the mouse or Arrow keys, position the end cap to the other 

end of the piece of the track.  

Lastly, draw 2 lines representing the track straight down the newly created 

drawing where the track should appear in the underlying picture. The width of the 

lines representing the rail may have to be changed to accurately represent the 
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width of the rail on the actual track. It is not necessary to change the color of the 

line from the default black, but user preference may want to color these lines 

silver to represent the rail color. Delete the underlying picture and the 9 in. 

rectangle that were put into the drawing as guides. Select all of the pieces 

comprising the track, group them together and drag them into the track stencil. 

Viola, a 9 in. straight of Code 100 Snap Track® that can be used to drag and drop 

into the drawing canvas.  

Note: If your layout uses different manufacturers track or switches, Stencils can 

be created for each of the manufacturer’s track products or they can all be 

placed into one single stencil.  
 

 

As mentioned earlier, this method is useful to make longer straight pieces of track 

representing set lengths of straight track. The intent is that these would be pieces 

of flex track that are on the layout and are either full size or cut down to a specific 

size.  
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The easiest way to construct a piece of straight that is longer is to use the 9 in. 

straight that has already been constructed. Drag two copies of the 9 in. straight 

onto the canvas and place them end-to end. Select one at a time the objects and 

ungroup them using either shift-control-u or the ungroup command from the 

“Arrange” toolbox on the Home tab. This action will cause a dialog box to be 

displayed stating it will break the link to the master. The master is the shape 

definition put into the stencil. Press “OK” to accept this dialog/action. Select the 

end caps for each of the straight pieces of track that are in the middle and press 

the delete key. This will remove these two objects from the screen.  

 

Select one of the tie pieces and using the control drag copy method copy two 

more ties to approximately the center between the 2 pieces of track. Select all of 

the ties for both of the track objects without the end caps. To do this, select the 

“Pointer” tool from the “Tools” toolbox and drag a selection box over the ties. Try 

to not include the outer ends of the rails next to the end caps or the end caps 

themselves.  

 Using the Home tab “Arrange”-“Position” select “Distribute Horizontally”. This 

will equally space the ties between the rails.  
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Carefully select both of the rails from one of the pieces of track and delete them 

using the delete key on the keyboard. This will result in the rails stopping halfway 

down the track. To correct this, select one of the rails and hold down the shift 

key. Using the left mouse button “stretch” the rail over the ties to the other end 

of the track piece. Holding the Shift key down while stretching the line 

representing the rail will result in the line being set at exactly a straight horizontal 

orientation. Repeat the process of stretching the line for the other rail. Select the 

entire 18 in. rail object and group it together using either a control-g or using the 

Home tab’s “Arrange”-“Group” command. Drag this into the Track Shape Stencil 

and rename it to “18” Straight”.  

 

This technique can be repeated using the 9 in. and 18 in. pieces to create 27 in. 

and 36 in. pieces of track for the stencil.  
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Generating a Switch ShapeGenerating a Switch ShapeGenerating a Switch ShapeGenerating a Switch Shape    
With the general track components defined in the Stencil the next step is to 

generate switch shapes. From either a scan or a internet image, an HO Code 100 

#4 switch machine picture can be used to generate a very accurate depiction of a 

switch machine. It doesn’t matter whether the switch machine picture is left or 

right for the beginning steps of the shape definition.  

Import the picture into the canvas using the “Insert”-“Picture” procedure. It is 

preferred that the switch machines to be oriented horizontally left and right, but 

the procedure will work for a vertical orientation as well. The horizontal track 

component of the switch is the same as a 9 in. straight piece of track for the #4 

turnout and  the radius is that of an 18 in. curve. It is possible to use the switch 

machine picture after being cleaned up from photo editing software for a switch 

representation or it is possible to generate the shape using the techniques listed 

in the Non-Picture Track Shapes section.  

To generate the non-picture 

representation of the switch 

drag a 9 in. straight object onto 

the canvas and use it as the 

sizing mechanism for the   

background photograph. Align and size the switch picture such that the straight 

portion of the switch picture matches up to the end points of the straight piece of 

track.  

Align the 9 in. straight on top of the switch, then select the straight track and 

“ungroup” it. This will cause the dialog box to appear stating it will break the link 

to the master. This step allows it to be broken back into the individual 

components that were used to generate the shape originally.  

Using the top center selection box on each tie, stretch the ties until they match up 

to the curvature of the outside of the curved part of the shape. This is about 17 of 

the ties from the 9 in. piece of track. Using the Control-Drag-Copy mechanism 

select one of the smaller ties and copy it near the top of the curved switch part. 

Rotate this tie 20⁰ counter-clockwise. Drag it until it meets up with the last long 
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tie and shorten it appropriate to match the underlying representation. Copy this 

tie and place it as the last tie for the end cap of the switch.  

Copy the end cap piece from the straight track. Rotate it 20⁰ counter-clockwise 

and place it in the appropriate position of the curved part of the switch.  

 

Draw in the rails for the curvature portion of the switch by using the line tool to 

draw the curved portion of the rails. This can be done by using the “Arc” tool, but 

it is not necessary for this to be precise, so the line tool is adequate for the 

drawing of the curve. Start the first part of the line at the 2
nd

 tie from the non-

curved switch end of the straight. Draw a line from that point for 8 ties ending 

just outside of the rail from the straight track. Clicking again on the end point of 

the just drawn line will allow for an extension of the line shape. This is another 

line that shares a vertex with the first line. Draw this line for 4 ties up the 

curvature of the rail of the underlying picture. Repeat this procedure 2 more 

times until the end of the rail reaches the end of the end cap for the track.  

Use the same procedure to generate the curved track for the inside rail.  
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To indicate the position of the switch throw bar, draw a black rectangle from the 

inside of the rail to the end of the throw bar. Do not draw the switch machine in 

the shape because these may be hidden under the track, use an alternative switch 

motor, or use a manual ground throw.  

The last step in defining this shape is to indicate the centerline of the curvature of 

the switch. This makes it easier to line up other track pieces to the switch when 

defining the layout. Using the line tool, draw a line from the center of the track 2 

ties in from the curve end cap, draw the extending out a little ways from the end 

cap away from the switch. Set the line width of this line to 1 pt. and using the 

“Line” tool’s option of Dashes, select the 3
rd 

dashed option. Additionally, it is 

useful to repeat this alignment line creation for both ends of the straight portion 

of the track. 

Delete the underlying picture and group the components of the newly drawn 

switch. Drag this shape into the Stencil and label it appropriately as to the 

direction of the switch, such as Left #4 Switch or Right #4 Switch. Next drag the 

switch back into the canvas and using the “Arrange”-“Rotate Shapes”, flip the 

shape vertically. This has now created a switch that has the turn out opposite 

direction. Drag this shape into the Stencil and name it the appropriate switch 

direction.  
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Save the stencil so that it is available for continuing use. 

Note: The switch shape drawing method can be used for other track shapes such 

as curved switches or different degree crossings. 
 

Add the track plan as shown: 
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Industries and BuildingsIndustries and BuildingsIndustries and BuildingsIndustries and Buildings    
The procedure used for creation of the track stencil can be used to define 

industries and buildings shapes that can be used on the layout. This aides in the 

track planning by allowing for placement relative to the track. Many of the plastic 

kit manufactures such as Woodland Scenics® and Walthers® provide 

measurements of building kits that can be used to draw “Top down” building 

representations. Each of these building representations can be added to a 

buildings stencil and used exactly like the track shapes stencil for drag and drop of 

industries or buildings onto the layout.  

Note: If there are building kits that are already constructed, then drawing a top 

down view is fairly easy to generate using measurements from the actual 

building. 
 

To learn how to do this start with the 

Woodland Scenics® kit for the Sicken 

Tire Company
1
 in HO scale. On the 

Woodland Scenics® website is a 

picture of the dimensions of the kit 

when built. This image is perfect for 

developing a top down view of the kit 

for a stencil representing the 

industry. Either capture or download 

the actual image from the website 

and save it to the local hard drive. 

Using the procedures for importing 

track pictures, import the picture into 

the canvas. Do not worry that it is too 

large as this will be taken care of through the manipulation of the size, by 

shrinking the picture.  

 

                                                
1
 HO Sicken Tire image  from http://woodlandscenics.woodlandscenics.com is reused with permission of Woodland 

Scenics®. 
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With the dimensions of the kit known, it is possible to shrink the image 

proportionally to the correct size by using the small white selection boxes on the 

corners of the picture. However, to get it to the correct size it is recommended to 

draw a rectangle that exactly matches one of the dimension on top of the picture. 

Use the width dimension on the picture for this effort.  

Note: When working down at this level it may be necessary to zoom in on the 

image so that the dimensions are easy to see and replicate.  
 

Using the conversion of 6 5/8 in. to 6.625 in decimal, build a rectangle that is 

equivalent to this size in width and 5 11/16 (5.6875) in depth. When the rectangle 

is drawn, a very thick border will appear around the rectangle. Select the “Line” 

dropdown from the “Shape Styles” and using the “Weight” menu option select “¼ 
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pt.” This is the thickness of the line that is drawn around the shape. It will be 

necessary to do this for all of the rectangles used to draw the shape.  

With the rectangle on top of the picture, resize the picture so that the width is 

exactly the same size as the rectangle. If the depth of the rectangle was set, then 

the size of the picture will fit into same size of the rectangle. It is okay to delete 

the rectangle at this point as the exact shape of the building will be constructed in 

the following steps.  

Draw a rectangle depicting what looks like the “lowest” level of the building. This 

is the “top” of the image from Woodland Scenics®. Do not worry about getting 

the small protrusions included at this step. Only draw the main rectangle.  

Note: if the starting point of the drawing will not exactly match where on the 

screen you wish to draw, then it is probably because the snap to grid option is 

selected. To turn off the snap to grid, select the “View” tab’s “Visual aids” 

extended dialog box. This is opened by selecting the bracket/right arrow at the 

bottom of the “Visual Aids” toolbar. In the “Snap & Glue” Dialog deselect the 

“Snap” option and select “OK”.  
 

It is now possible to draw the additional “small” rectangles/protrusions from the 

shape on the top wall. Draw 3 small rectangles with a line width of ¼ pt. matching 

the outside outline of the underlying picture. To get the shape correct, use the 

“Union” operation to merge the 4 rectangles together. This will form the top side 

of the image.  

 

To draw the right side, draw 2 rectangles representing the depth and width of the 

right side of the picture and the longer bottom side picture. To get the correct 

shape union these two shapes together.  
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Draw the remaining bottom rectangle. Because the left or main building overlaps 

on top of the right side constructed object, it will be necessary to make that 

object transparent. To do this select the constructed object and from the “Home” 

menu tab’s “Shape Styles” select the pull down menu for the “Fill” option. Select 

the menu item at the very bottom of this menu “Fill Options”. This will bring up 

the Format Shape toolbar on the right side of the screen. Open the “Fill” options 

by selecting the white triangle next to the Fill text. The last option in this list is 

“Transparency”. Select a Transparency of about 50%. This will let the original 

picture behind the drawing be seen as well as the other rectangles that have been 

drawn “behind” this object. Draw the remaining center rectangle to the correct 

size. To complete the shape reselect the “transparent” object and reset its 

transparency back to “0%”. 
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It is very advantageous at this point to “group the object” into a single entity 

before placing it into a Stencil. From the Home tab, select the “Pointer tool”. Drag 

a square around the objects to put into the single shape. And either use a Control-

G or from the Home tab select the Group function from the Arrange toolbox and 

group the objects together. 

This can be done to represent all of the buildings, kits and industries. It isn’t 

necessary to replicate minute details of the kit on these representations, just 

make sure the general shape is constructed so that it accurately represents the 

object from a top down 2 dimensional view. 

Create a new Stencil/Shape library using the same technique used for the track 

and title this one “Buildings”. Using the same process of drag and drop the 

buildings into the Shape/Stencil. To place onto the layout, the shape can be 

selected and using the click and drag method be placed onto the canvas. Make 

sure these objects are in different layer than the track layer titled “Buildings”. 

It is useful when placing an industry onto the layout to give that industry a name. 

This makes the layout customized to the developer of the layout. “Uncle Bill’s 

Tires” is a lot more personalized than “Sicken Tire”. When placing the shape into 

the stencil it should be named or labeled in the Shape Stencil, but to the kit name 
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from the manufacturer. This way it is easy to identify what kits need to be 

constructed when the layout plan is complete. 

When the object is placed from the shape stencil onto the canvas title it to reflect 

the personalized name of the object. To label the object select the text toolbox 

option “A Text” from the “Tools” menu on the Home tab. When the mouse is 

moved into the drawing canvas the cursor will change to a text entry cursor. This 

is a small “plus” sign with a box to the lower right. Click and drag a text box that is 

the size of the building. Do not worry that the font is monstrous in size as the 

“Font” options on the Home tab allow for a smaller font to be selected. For this 

building it is suggested that using a 6 pt. font size will not overflow the sides of 

the building. 

The text box containing a name is just another object that has been added to the 

drawing. This text box around the actual building can be manipulated like any 

other object in that it can be sized, rotated, color added to it, and even the font 

color. Most of these capabilities are through the “Font” toolbox on the Home 

Menu. 

Note: Each object that is placed onto the screen can have text put “into” that 

object’s definition. All circles, squares, rectangles, buildings, etc. Text is inserted 

into the object by selecting the object and then typing the selected text. Visio® will 

automatically enter the text centered in the object inside a text entry box. Clicking 

outside of the object will close the box and add the text to the object. 
 

 



43 

 

Terrain, Tunnels and RiversTerrain, Tunnels and RiversTerrain, Tunnels and RiversTerrain, Tunnels and Rivers    
At this point it is just dragging, rotating and aligning up track and curve pieces to 

create the layout. Most layout plans have varying terrain to add interest to the 

track plan. This can be represented in the 2D representation in Visio®. To 

represent different levels of a layout, it is easier if the other levels are 

represented by a color that is different than then layout base color. It is useful to 

pick primary and secondary computer colors: 

Computer Primary Color Computer Secondary Color 

Red Up 1 level Cyan Up 2 Levels 

Green Layout Base Magenta Up 3 Levels 

Blue Water Yellow Down 1 level 
 

For ease of use later, create a legend using these colors so that each color can be 

seen in its appropriate hue. This is a result of having the transparency on every 

level (except the Layout Base and Water) set to about 50% so that the underlying 

track (tunnels) can be seen easily.  

To create the legend, draw a tall rectangle on the canvas outside of the room of 

the layout. Make this rectangle about ½ of an inch wide and 3 inches tall. Color 

this rectangle with the same color as the base layout (Green). Draw a ½ in. x ½ in. 

rectangle and place it over the very bottom of the green rectangle. Copy this 

rectangle and place one exactly right above the bottom rectangle. Using the 

shape fill color the bottom rectangle blue and the second rectangle yellow. These 

represent the water and the level 1 layer down.  

Copy the yellow rectangle and using either the mouse or arrow keys, place the 

pasted rectangle up a full skipped ½ in. of the green rectangle. This lets the 

ground be a level 0. Drag the top of this rectangle until it matches the top of the 

green rectangle. It should be 1 ½ in. tall. Using the Fill a shape, change the color of 

this to a bright red. To tone it down go into the “Fill Options” and change the 

Transparency of this rectangle to 50%. It will now change the color of the 

rectangle to a brown as it is blended into the green beneath it. Repeat these steps 

creating rectangles for the up 2 and up 3 levels 
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It is possible to number these levels, but additional blank lines must be placed 

into the text of the box to get it to align properly with the box above it. 

 

Add a rectangle to the drawing canvas to represent terrain. It doesn’t matter 

where this rectangle is located or its size. Move the rectangle to where its upper 

right corner matches the top right corner of the base layout. Select the rectangle 

representing up 1 level from the legend. It is the red filled rectangle with 50% 

transparency making it brown. Using the “Format Painter” option from the clip 

board copy the style of the brown rectangle onto the newly created rectangle. 

The white rectangle will turn brown and any track underneath will show through. 



45 

 

 

With the newly colored rectangle selected (the white sizing rectangles are 

displayed), select from the “Tools” menu the Line tool. The white boxes disappear 

and 4 blue dots appear on the 4 corners of the rectangle. Each of the blue dots 

represent a drawing point of the rectangle. Select the one on the lower right and 

drag it all the way to the bottom (the opposite side of the layout) straight down. If 

the point has successfully been selected, the cursor will change to a 4 arrow 

cursor representing that the point can be moved.  

Move the top left rectangle point to the left until it is to the other side of the 

window at the beginning of the straight track portion. Move the lower left corner 

of the rectangle to a point just above the track on the bottom of the top side of 

the layout. 
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The rectangle now crosses many parts of the layout that want to be seen and 

even into portions of the room that are outside of the base layout. This can be 

fixed by the addition of new control points to the shape. Each of these new 

control points can be manipulated/moved in exactly the same way as previously 

described. Hold down the control key (CTRL) and put the cursor on a portion of 

the outline of the newly deformed rectangle and press the left mouse button. This 

will cause the creation of a new control point on the shape. The object is a 

pentagon and no longer a rectangle. Drag the new point such that it would 

represent a tunnel entrance for the top straight on the layout.  

Add another control point just below the one on the bottom of the top of the 

layout. This will be used to represent the “upward” directional portion of the 

terrain. 

Add control points and manipulate the shape until it looks like the one shown 

below.  
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In order to get the track in the correct placement on the terrain it is necessary to 

move either the terrain or the track in the ordering it was drawn into the layout. 

This can be accomplished in one of two ways: Send the terrain to the Back, and 

then move it forward one level at a time. Or, select each piece of track that is to 

be on top and use “Bring to Front” to reposition it on top of the terrain. Using 

either or a combination of these methods will generate the correct placement of 

some of the track under the terrain, indicating a tunnel. Select the terrain and on 

the “Home” tab use “Arrange”-“Send to Back”. This will place the terrain under 

everything on the drawing, even the room. As such it will disappear from being 

visible on the canvas. Without de-selecting the terrain, use the “Arrange”-“Bring 

Forward” to bring the terrain forward of one entity at a time. This will need to be 

repeated until the track in the tunnel is masked “red”, and the track on top is 

clear. 
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The deformation of a rectangle, by adding new control points, can be used to 

create water pathways, rivers, mountains, and all representations of terrain. It is 

not limited to only 5 levels as in this tutorial. 

Note: using the “Arrange” mechanisms on the Home tab allow for editing and 

manipulation of many items on the canvas. The ordering of what shows on top 

can be manipulated for all objects on the screen. 
 

Creeks, ponds, rivers and waterways are generated in the same manner as the 

first level of the terrain. Draw a rectangle and place it on the layout. Using the 

“Clipboard”-“Format Painter” copy the water fill color from the legend. Use the 

“Tools”-“Line Tool” to move and add control points to the water. 

To represent terrain that is below the base layout area use the same technique 

and copy the fill characteristics to the -1 legend value. 
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Control Panel DiagramControl Panel DiagramControl Panel DiagramControl Panel Diagram    
With the track plan now complete, it is possible to use Visio® to aide in other 

layout planning activities. The first is to design a control panel diagram from the 

existing track plan. This control panel diagram will exist in a new page inside of 

the same file as the layout on a new page titled “Control Panel”. This diagram can 

be used for a layout switching control panel or simply as a schematic to verify that 

the desired train directional switching is correct. 

At the bottom of the canvas on the left just before the shape/stencil toolbox is a 

listing of all of the pages in the current file. Currently only “Page-1” exists. To the 

right of “Page-1” is a selection mechanism for selecting a specific page, and a plus 

“+” symbol inscribed in a circle. This is the “Add Page” to the working file. A right 

mouse click on the tab of the page will bring up a list of options to perform on the 

page. Select Rename and change the name of the page to “Control Panel”. The 

same technique can be used to rename “Page-1” to “Layout”. 

A left mouse click onto the page name tab at the bottom is used to switch 

between the pages of the Visio® file. Switch back to the “Layout” page and using 

the “Layers”-“Layers Properties” remove the check mark for the visible of all of 

the layers and select “OK”. What will be left is only the track and the terrain. The 

goal is to have only the track remain visible. Select the terrain and the legend and 

add them to a new Layer called “Terrain” and set that layer’s visible to off. At this 

point all that remains on the canvas is the track. 

Using the select “All” method of “Control-a” will select all of the track on the 

canvas. Add these to another new layer titled “Track”. Leave this layer visible. 

Select all of the track and from the “Home”-“Clipboard” toolbox select “Copy”. 

This will make a copy of all of the track into a temporary holding area of the 

computer’s memory. Select the “Control Panel” page from the bottom page tabs 

and paste the track onto the “Control Panel” page. 

For this tutorial, a control panel would probably sit between the two major parts 

of the layout, so the layout as drawn rotated 90⁰. Using the “Control-a” method 

select all of the track and using the group rotation component at the top of the 

group rotate the entire layout representation 90⁰ counter-clockwise. 
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In the tutorial diagram, there are 6 switch machines, two sidings and one loop 

that will need isolation and be implemented as a reversing loop. The schematic of 

the drawing layout can be reduced to showing the major areas as follows: 
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As can be seen in this diagram the basic part of the loop that went into the tunnel 

is simplified to just showing the circle the track actually traverses. This 

simplification is used to indicate the primary path for the track.  

The next step is to convert the track plan into a control panel layout. The first step 

in this process is to “Lock” the layer of the track so that it does not interfere with 

any of the drawing of the control panel. Using the “Editing”-“Layers”-“Layer 

Properties” select “Color” for the Track layer. This must be done before locking 

the layer as one it is locked, this option is not available. Select a yellowish color 

from the color pull down list. The logic behind this maneuver is to allow for the 

overlaid control panel schematic to be easily distinguished from any new drawing 

on the canvas. Lastly, lock the track layer and press “OK”.  

The control panel layout described here will denote toggle switches and lamps to 

indicate the switch direction. To indicate both the toggle and the lamps can be 

done using the shapes already defined in Visio®. On the “Shapes” toolbox select 

“Search” and enter the text “Nut”. This will bring up a list of Nut shapes that have 

already been defined by Microsoft. If the “Hex nut top” shape does not appear, 

select the “More results..” Drag the “Hex nut top” to the canvas. This will cause 

the Shape Data dialog box to appear asking for the Thread Diameter of the nut. 

For simplicity, just use the 1 ½ value. 

Add a fill color of light gray or sliver to the nut and increase the 

line size from ¼ pt. to 1 pt. and color it black. This makes is look a 

little more color appropriate to a hex nut from the hardware 

store.  
 

Inserting a circle shape that fills the center of the nut represents 

the lamp. Do not worry about applying a fill to this circle as it that 

will be done in the following steps. Draw another circle, with a ¼ 

pt. line, that fits exactly the outside dimensions surrounding the 

hex nut and change the fill to “No Fill”. This provides the 

separation of the rotation of the hex nut when adding it to a 

control panel. Select both the nut shape and the circles and group 

them together. 

 

 

Note: This is an excellent time to learn about connection points. Connection points 

allow for exact placement of lines between objects that are on the screen. They 

can used to generate routing lines between objects, much like the traces on a 
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printed circuit board. For the purpose of the control panel they will be used to 

indicate connectors on the toggles or lamps for track paths between the switches. 

 
 

With the nut/circle selected in the canvas, select from the Home 

tab the “X” in the “Tools” toolbox. This is the insert or select a 

connection point icon. Selecting this will bring up a gray square 

around the center of the nut. Hold down the control key on the 

keyboard and using the mouse’s left mouse button click in the 

center of the square around the center of the nut. A red dot will 

appear indicating the position of the connection point. It is 

possible to add more connection points, but for this tutorial and 

laying out a control panel this is the correct placement. The use of 

the connection point will be shown later. 

 

 

Make a copy of the nut using the “Clipboard”-“Copy” command as the shape will 

be used for multiple shape creations in the following steps. 

 

To represent a green lamp, select the center circle and color it to 

a dark green. This will be the “right of way” colorization for the 

lamps.  

 
 

For a red lamp, paste the nut shape from the one copied before 

the previous step. Fill this one to a dark red.  

 

 
For a toggle button, past the nut shape again onto the drawing 

canvas. Select the center circle and color it to a black color. From 

the “Shapes”-“Search” search for a “round rectangle”. This will 

bring to the Shapes toolbar various versions of the round 

rectangle object. Select the one from the Drawing Tool Shapes 

titled “Rounded rectangle” and drag it to the canvas. Change the 

size of this object to be 0.25 in. in width and about 0.4 in. in 

height. Reposition the “pill shaped” round rectangle to where the 

bottom is resting inside the bottom of the black circle.  
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To make the toggle lever appear like a vertical lever, open the “Format Shape” 

toolbox from the more options portion of the “Shape Styles” on the Home tab. In 

the Format Shape select a FILL of “Gradient fill”. This will color the pill a funny 

color, but this is easily remedied. Under the “Gradient Stops is a horizontal box 

with 2 end chevrons and a center chevron. Select the chevron on the right end of 

the box and then change the “Color” directly underneath to a medium gray. 

Select the toggle lever and the underlying nut and group them together.  

Create a new Shape Stencil titled “Lamps” and put the lamps and the toggle into 

the shape library. 

On the canvas, drag one of the toggle buttons to each of the switch locations on 

the track drawing. 

 

For each branch of the track past a toggle, place a lamp. This can be a personal 

preference as to either red or green.  
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Before starting the next step of drawing the lines between the lamps and toggles, 

verify that the snap features are all turned on. On the View tabs under the visual 

aids additional capabilities in the "Snap & Glue" dialog make sure all of the snap 

options are selected. This allows a line to be drawn from one object to another 

such that when the object is moved, the line will move with the object. 

Using the Line tool from the “Home” tab’s “Tools” toolbox draw a line from the 

center of each toggle to center of each lamp the switch represents. A green box 

will highlight at the center of the toggle and the lamp to indicate the correct 

positioning. First do this for all of the Green lamps, then do it for all of the Red 

lamps. This is to make sure that the line being drawn is not considered a 

continuation of the line, but rather a line object in its own right.  
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The next step is to make the track connections between sections indicated by the 

lamps. Don’t worry that the organization of the “schematic” is incorrect as this 

will be corrected shortly. Draw a line for each siding that travels from the center 

of the lamp to the end of the siding. If space is not appropriately available, extend 

the line of the siding beyond the end of the track. 

Try selecting and moving a toggle or a lamp around on the canvas. The lines 

between the objects will stay in position as the object is moved to a different 

place. Selecting one of the connector lines and using the “add a connection point 

with the Control-Left mouse click” onto the line will allow for the line to be 

expanded to indicate a loop or other “change”. 
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Since a toggle and the two lamps are considered a single object, it is recommend 

that each switch’s toggle and two lamps be “grouped” together. This way, 

movement can occur to organize the control panel layout without having to move 

each switch’s components independently.  

At this point it is time finish out the “look and feel” of the control panel. There are 

two problems currently with the way it is drawn, the first is that the lines are a 

very narrow line and not the wide size consider appropriate for a control panel. 

The second is that the lines appear on top of the toggles and switches. Both of 

these problems are easily corrected with techniques that have already been 

presented, they are just time consuming.  

For the line width, select each line and with the “Shape Styles”-“Line”-“Line 

Weight”  to a 6 pt. line. Before moving to the next line, use the “Arrange”-“Send 

to Back” to move it behind the toggles and or lamps. Do not worry that it goes 

behind the actual track representation of the layout. This can be fixed by making 

the track layer not visible through the Home tab’s “Editing”-“Layers”-“Layer 

Properties” Mechanism. 
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The organization of the control panel can now be rearranged to provide a linear 

representation of a control schematic.  

The last piece of the control panel is to provide labels to areas of interest of 

where particular industries are located. Using the text tool it is possible to place 

labels onto Control Panel where appropriate. 
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MeasurementsMeasurementsMeasurementsMeasurements    
Up to this point the size and measurement indicators have been set by using the 

size of the object on the bottom of the canvas. Visio® provides mechanisms to 

allow for accurate dimensional specifications to be shown on the screen. In the 

Shapes-Search perform a search on the word “dimension”. This will bring up a list 

of the dimensioning shapes that are available in Visio®. The primary dimension 

tools to use are from the “Rack-mounted Equipment” shape stencil. These are 

“Dimensioning-horizontal” and “Dimensioning-vertical”.  

Return to the Layout page and drag an instance of the “Dimensioning-horizontal” 

shape onto the screen. The initial size of the object is 16 in. or 1 ft. 4 in. The units 

that this shape represents can be changed by a right mouse click on the object 

and selecting “Precision & Units”. From this dialog box the precision (how 

accurate) can be changed and the units to other US or Metric values.  

Drag the measurement object 

to just above the room on the 

top left corner. Select the 

“gray” selection box on the 

lower right of the object and 

drag it until it reaches the other 

side of the room. The 

dimension should now be 

exactly 10 ft. 7 in. A similar 

procedure can be done with the 

Dimensioning-vertical for the 

vertical measurement of the 

room. 

 

It is useful to experiment with  

measurement tools from the shape search for other dimensions on the layout. As 

with all of the other objects in the canvas, it is useful to place all measurement 

objects into a new layer titled “Measurement”. This way the measurement lines 

can be turned on or off easily with the visible checkbox of the Layer’s Properties. 
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BenchworkBenchworkBenchworkBenchwork    
Planning benchwork is paramount to the development of a good layout. With 

Visio® being a 2D CAD package, it is 

possible to plan the benchwork for the 

underlying foundation for the layout. For 

the tutorial layout assume the option is to 

use an L-Girder benchwork. The L-Girder 

has been widely accepted as the way to 

build a sturdy platform for building a 

Model railroad. This uses beams 

constructed into an L shape that allows 

Joists to be placed easily for either a cookie 

cutter base or splines for track. For the 

tutorial layout the L-Girder will be 

constructed of 1 in. x 4 in. vertical components and 1 in. x 2 in. lumber for the 

horizontal component. Risers will be constructed of 2 in. x 2 in. legs and 1 in. x 2 

in. cross braced supports.  

To define this 

placement and 

design of both the 

risers and the L-

Girders is a fairly 

easy task in Visio®. 

Add a new page to 

the drawing and 

rename it to 

“Benchwork”. From 

the Layout page 

select only the 

“Base Layout” 

image and copy it 

onto the new 

Benchwork page.  
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From this view it is apparent that there is a need for joists to handle the 

curvatures of the base layout. But the first thing to do is to define where the L-

Girders will be placed to support the joists. Draw a 1 ½ in. high rectangle that is 

about 6 ft. in length. 1 ½ in. represents the top width of the 1 in. x 2 in. board that 

serves as the top of the L-Girder. Select a color from the “Style Shapes”-“Fill” and 

color the L-Girders all to a common colorization. Copy and paste this rectangle 5 

times so that there are 6 copies of the rectangle on the canvas.  

Using the vertical shape tool, 

drag a copy of the vertical 

dimension object to the canvas 

and align it with the top of the 

layout. Make the height of the 

dimension to 6 in. move one of 

the rectangles until it is exactly 

6 in. from the top of the layout. 

Copy the dimension object and 

place it on the inside flat 

portion of the top “pill”. Move 

one of the rectangles until it 

aligns horizontally with this 

measurement. 

 

 

 

Select the “carefully” placed 4 

rectangles and align them to the right 

using the Home tab “Arrange” 

alignment mechanism. Move these 4 

rectangles until they are flush with the 

right side of the base layout. Next 

stretch each rectangle until it either 

meets or just barely touches the left 

side of the base layout. 
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Using the horizontal 

dimension tool create two 

dimension objects that are 6 

in. in width and place them at 

the vertical center of the 

layout. This is where the 

layout is thinnest in the 

horizontal dimension. Rotate 

each of the remaining L-Girder 

pieces 90⁰ so that they appear 

as vertical L-Girders. Move 

one girder to where it is 6 in. 

from the inside of the curve 

and the other to where it is 6 

in. inside the back (Right) side 

of the base layout. Resize 

each of these until each abuts 

against the horizontal L-

Girders on top and bottom.  
 

 

 

 

The next step is to decide where to 

place the risers for to support the L-

Girders. For this layout, assume that 

the maximum spacing for an L-Girder 

riser will be no more than 30 in. and 

placement of the outside edge risers 

will be 16 in. from the edge of the base 

layout. Place a horizontal dimension 

measurement object that is 6 in. from 

each edge of one of the pill halves. 

Place a second 6 in. horizontal 

measurement object from the right 

edge of the base layout. Using the 

rectangle tool draw a vertical rectangle 

that is 1 ½  in. wide that spans across 

the two horizontal L-Girders at the 6 in. 

distance from the end. Using the “Fill” 

mechanism, make this shape a different  
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color than the L-Girders. Resize the riser rectangle until it leaves the 3/4 in. of the 

width of the L-Girder on both the bottom and the top L-Girders. 

Copy the riser object and place it to where it abuts against the right side 6 in. 

measurement object at the same distance between the L-Girders. Using the 

control-drag copy mechanism, make a copy of the riser and place it in between 

the two other risers. Deselect all of the riser and then select them one at a time 

starting from the left most riser. Using the “Arrange”-“Align” tool align the three 

risers to the top. Without deselecting the risers, select the “Position”-“Distribute 

Horizontally” mechanism to move the center riser to where it is exactly halfway 

between the other risers. Generate a copy of the horizontal dimension object for 

the distance between each of risers. Copy the risers and the measurements and 

place them on the other “pill” shape to where they match the alignment of the 

other “pill” shape. 

 

 

The next step is to generate the risers to support the vertical L-Girders previously 

put in between the horizontal L-Girders. To do this copy one of the risers already 

on the screen and rotate it 90⁰. Place a 12 in. vertical dimension object in 

between the two vertical L-Girders where one end meets against the horizontal L-

Girder. Move the riser until it sits between the two vertical L-Girders at the 12 in. 

offset distance. Repeat this step to generate the other riser on the opposite end. 
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Lastly, generate a vertical dimension object that indicates the distance between 

the two new risers. If everything went correctly, all risers are on the layout and 

the dimensions between any of the risers is less than 30 in. 

 

The risers actually will exist under the L-Girders, so select all of the L-Girders and 

using the “Arrange” toolbox, bring them to the top. 
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Place the joists across the L-Girders by 

drawing joist rectangles on the L-

Girders. This is probably an exact 

science, but it seems to be more of a 

designer’s preference that dictates 

where the joists are located. Using the 

rectangle tool, draw a rectangle that is 

¾ in. in width and stretches from the 

top wall until it meets the bottom of 

the flat portion of the center of the pill. 

Using the “Fill” change the color of the 

joist to a different color of that used for 

the L-Girders and the Risers.  

 
 

It is now just a matter of placement of the joists so that they are equally spaced at 

intervals that will support the actual layout. Assume that there a 6 joists for each 

of the “pill” sections of the layout and 3 for the portion in between. Using the 

copy and paste mechanisms along with the align toolbox, these can be placed to 

an approximate location. Use the “Distribute horizontally or vertically” where 

appropriate and place them at equidistant locations from each other. Lastly, size 

each joist so that it meets two edges of the base layout.  
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Once the placement and the sizing of the risers has been determined, the 2D 

drawing tool can be used to design the actual risers. Select all of the risers from 

the drawing and copy them using either Control-c or the “Clipboard”-“Copy 

command, but do not paste them anywhere. Add a new page titled “Risers” to the 

drawing and paste the risers to the canvas using either Control-v or the 

“Clipboard”-“Paste” command. Only 1 horizontal and one vertical riser rectangle 

is needed as the others are simply duplicates and can be deleted. Rotate the 

vertical riser rectangle into a horizontal position, 90⁰.  
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The purpose the riser rectangles, at this point, is to provide an exact size for the 

width of each of the risers. The next step is to define the height above the ground 

the base layout will reside. Just for ease of design, use 48 in. as this measurement. 

Subtract off the thickness of the base layout, for this use ½ in. for ½ in. plywood, 

leaving 47 ½ in. for the riser, L-Girder and Joists. Using a 1 in. x 3 in. riser takes this 

down to 45 in. (3 ft. 8 in.).  

This is an excellent place to learn about guidelines. These are non-drawing lines 

that are horizontal or vertical that allow for objects to “snap” to them. The way to 

put a guide line on the canvas is to left mouse click inside of the ruler, either on 

the left or the top of the canvas. Holding down the left mouse button, drag the 

guideline into the drawing until it meets to the left side of one of the risers. 

Repeat this process for the other side of the riser. Drag one from the top ruler 

until it reaches the bottom of the riser.  

 

Drag a Dimensioning – vertical object to the screen and move it around until the 

top of the measurement object meets with the guideline. A small green square 

will appear indicating it is okay to snap to the guideline. On the opposite end of 

the measurement object stretch it until it is 38 1/4 in. in height. Drag a guideline 

from the top ruler until it meets up with the bottom of the measurement object.  

Draw a rectangle that is 1 ½ in. in width, but fills the space between the guidelines 

in height. The green snap boxes will indicate when the rectangle meets the 

guideline. Repeat this step for the opposite side of the riser.  
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The riser legs must be cross braced to provide stability. This is shown in a 2D 

diagram by the addition of 1 in. x 2 in. cross braces placed at 45⁰ to the legs. To 

draw this in Visio®, copy and paste one of the leg pieces and using the rotate 

mechanism on the top of the rectangle rotate it 45⁰ counter clockwise. Move the 

cross brace until the top most corner meets up to the upper left corner of the left 

most leg. This will place the brace in a “proper position” for providing the cross 

brace capability. On the bottom of the cross brace change the length of the brace 

until the bottom most portion of the bottom of the brace meets up to the right 

side of the right brace. Both the top and the bottom of the brace should extend 

beyond the edge of the legs of the brace.  
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The leg “brace” should still be in the 

clipboard from when it was copied 

previously. Paste another copy of the 

leg and move it to where it is on the 

outer side of the left most leg of the 

riser. Select the cross brace and then 

the newly pasted “outside” leg and 

using the “Operations”-“Subtract” 

option, remove part of the cross brace. 

Repeat this process for the opposite 

side of the brace. 

 

 

 

 

 

 

Copy and paste the cross brace. Using 

the “Arrange”-“Position”-“Rotate 

Shapes” flip the pasted brace 

horizontally. This will make a mirror 

image of the original cross brace. Move 

this brace until it meets to the right side 

top of the right most leg. 
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To complete the riser a horizontal component should be added to guarantee that 

the riser will not move. Use the top piece of the riser (this is the one copied from 

the other page) for the horizontal rectangle/stabilizer. If more stability is required 

a second horizontal stabilizer can be added at the bottom of the cross braces. 

 

The last step with the risers, is to determine how much lumber will be required to 

build a riser. This can be estimated by taking a copy of the riser, placing the 2 in. x 

2 in. pieces end to end, and by placing the 1 in. x 2 in. pieces end to end. (Note: 

one cross brace will need to be “flipped vertically” to make the ends line up. 

Horizontal dimension measurements can accurately show the length of each 

piece and the total length of the lumber necessary for a riser. 
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Elevation RepresentationElevation RepresentationElevation RepresentationElevation Representation    
Visio® is a 2D representative drawing package and not a 3D representation of the 

layout. However, the mechanisms that have previously been described can be 

used to draw a front or side view of the layout. Add another page to the drawing 

and rename this one to “Elevation”. Draw a horizontal 1 in. thick rectangle on the 

canvas that is 10 ft. wide. Color this rectangle the same color as the layout base as 

this is a representation of that piece of the layout drawing. The Home tab’s 

“Format Painter” is a great tool to help with this step. On the Layout page, select 

the base layout. Next select the “Format Painter” and switch over to the Elevation 

page. Select the horizontal rectangle that was just created. If everything went 

correctly, the base elevation representation is the same color as the base layout 

on the Layout page. 

 

Adding additional rectangles are used to represent ½ or ¾ in. plywood and can be 

rotated to an appropriate climb for the track, such as 1⁰, 2⁰ or 3⁰. This mechanism 

allows for transition between various layers and the profile of the terrain. 

In this phase of the drawing it is very useful to have rise/run charts for the various 

grade angles. The following charts are helpful for determining the distance up a 

curve or straight grade allows by the curvature radius. Appendix A contains Grade 

charts that show a run up to 3 in. in climb. The curve charts are start at the N-

Scale 9.75 in. then increment 1 in. up to a 30 in. radius. HO would start at 15 in. 

radius on these charts. 
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The technique of showing the elevation can be used to represent a helix for 

elevation transitions as shown below: 
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InventoryInventoryInventoryInventory    
Because of the ease of the drag and drop of shapes in Visio®, the design becomes 

more complex with additional track, curves and buildings added to the layout. For 

a complex design it is easy to lose track of the number of times a building has 

been used or to keep track on the number of left or right switches. This method 

can be used to assist in that computation. 

From the Layout page change the visible value for all layers except the track to 

not be visible. Select all of the track on the screen using either the control-a 

command or by dragging a selection box around the layout. Copy the entire track 

into the copy clipboard using either a control-c command or by the use of the 

Home tab’s “Clipboard”-“Copy” command. Create a new page and rename this 

new page to “Inventory”. Select this page to be the current drawing canvas and 

paste the track layout onto this page. 

The next step is to divide the canvas into 4 conceptual 

quadrants. This is so that it is possible to separate all of 

the pieces of track with a “click-and-drag” process. 

Using this method will result in a separation where by 

the pieces of track can be separated further to quantify the track pieces. 
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A benefit of this organization is that with a count of the individual components, 

even the amount of cork required for the track can be calculated by summing 

up the amount of track in the inventory. Curve radius length (circumference) is 

calculated by using the formula: 

 

� = 2�r. 

 

For the ½ radius divide that by 2, for the ¼ divide by 4, etc. 

 
 

To count various buildings perform a similar technique of copying the building 

layer from the layout page to a new page titled “Buildings”. Past the buildings and 

sort them by type, or shape. This will allow for a concise count of specific building 

kits that are being used on the layout. 
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EpilogueEpilogueEpilogueEpilogue    
This tutorial has presented some of the basic commands and techniques that can 

be used from Visio® in order to design a track plan. Although the tutorial doesn’t 

cover every mechanism in the Visio® application, it does provide enough of a 

starting point as to be able to build your own track plan for your layout.  

The Stencils/Shape libraries that are created in this tutorial can be used for your 

custom layout and should not need to be generated again (unless you are in 

another scale). Be sure to save often and to experiment with the various 

components of the tool either by searching for keyword in the Shapes or by the 

Help mechanism on the top right in the shape of a Question Mark “?”. Using this 

drawing package in my opinion is a very comprehensive method for designing a 

2D representation for your model railroad layout. Even one for outside using the 

LGB shape stencil. 
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Appendix A. Grade ChartsAppendix A. Grade ChartsAppendix A. Grade ChartsAppendix A. Grade Charts    
 

3 degree  Grade 

Run Rise Run Rise Run Rise 

1 0.0524 29 1.5198 48 2.5156 

5 0.2620 30 1.5722 50 2.6204 

10 0.5241 32 1.6770 52 2.7252 

12 0.6289 34 1.7819 54 2.8300 

14 0.7337 36 1.8867 56 2.9348 

16 0.8385 38 1.9915 58 3.0397 

18 0.9433 40 2.0963   

20 1.0482 42 2.2011   

24 1.2578 44 2.3059   

26 1.3626 46 2.4108   

 
3 Degree Grade Curves 

Radius length Rise 1/2 Rise 1/4 Rise 1/8 Rise 

9.75 61.2611 3.2106 30.6305 1.6053 15.3153 0.8026 7.6576 0.4013 

10 62.8319 3.2929 31.4159 1.6464 15.7080 0.8232 7.8540 0.4116 

11 69.1150 3.6222 34.5575 1.8111 17.2788 0.9055 8.6394 0.4528 

12 75.3982 3.9515 37.6991 1.9757 18.8496 0.9879 9.4248 0.4939 

13 81.6814 4.2807 40.8407 2.1404 20.4204 1.0702 10.2102 0.5351 

14 87.9646 4.6100 43.9823 2.3050 21.9911 1.1525 10.9956 0.5763 

15 94.2478 4.9393 47.1239 2.4697 23.5619 1.2348 11.7810 0.6174 

16 100.5310 5.2686 50.2655 2.6343 25.1327 1.3172 12.5664 0.6586 

17 106.8142 5.5979 53.4071 2.7989 26.7035 1.3995 13.3518 0.6997 

18 113.0973 5.9272 56.5487 2.9636 28.2743 1.4818 14.1372 0.7409 

19 119.3805 6.2565 59.6903 3.1282 29.8451 1.5641 14.9226 0.7821 

20 125.6637 6.5858 62.8319 3.2929 31.4159 1.6464 15.7080 0.8232 

21 131.9469 6.9150 65.9734 3.4575 32.9867 1.7288 16.4934 0.8644 

22 138.2301 7.2443 69.1150 3.6222 34.5575 1.8111 17.2788 0.9055 

23 144.5133 7.5736 72.2566 3.7868 36.1283 1.8934 18.0642 0.9467 

24 150.7964 7.9029 75.3982 3.9515 37.6991 1.9757 18.8496 0.9879 

25 157.0796 8.2322 78.5398 4.1161 39.2699 2.0580 19.6350 1.0290 

26 163.3628 8.5615 81.6814 4.2807 40.8407 2.1404 20.4204 1.0702 

27 169.6460 8.8908 84.8230 4.4454 42.4115 2.2227 21.2058 1.1113 

28 175.9292 9.2201 87.9646 4.6100 43.9823 2.3050 21.9911 1.1525 

29 182.2124 9.5493 91.1062 4.7747 45.5531 2.3873 22.7765 1.1937 

30 188.4956 9.8786 94.2478 4.9393 47.1239 2.4697 23.5619 1.2348 
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2 Degree  Grade 

Run Rise Run Rise Run Rise Run Rise 

1 0.0349 29 1.0127 48 1.6762 68 2.3746 

5 0.1746 30 1.0476 50 1.7460 70 2.4445 

10 0.3492 32 1.1175 52 1.8159 72 2.5143 

12 0.4190 34 1.1873 54 1.8857 74 2.5841 

14 0.4889 36 1.2572 56 1.9556 76 2.6540 

16 0.5587 38 1.3270 58 2.0254 78 2.7238 

18 0.6286 40 1.3968 60 2.0953 80 2.7937 

20 0.6984 42 1.4667 62 2.1651 82 2.8635 

24 0.8381 44 1.5365 64 2.2349 84 2.9333 

26 0.9079 46 1.6064 66 2.3048 86 3.0032 

 

2 Degree Grade Curves 
Radius length Rise 1/2 Rise 1/4 Rise 1/8 Rise 

9.75 61.2611 2.1393 30.6305 1.0696 15.3153 0.5348 7.6576 0.2674 

10 62.8319 2.1941 31.4159 1.0971 15.7080 0.5485 7.8540 0.2743 

11 69.1150 2.4136 34.5575 1.2068 17.2788 0.6034 8.6394 0.3017 

12 75.3982 2.6330 37.6991 1.3165 18.8496 0.6582 9.4248 0.3291 

13 81.6814 2.8524 40.8407 1.4262 20.4204 0.7131 10.2102 0.3565 

14 87.9646 3.0718 43.9823 1.5359 21.9911 0.7679 10.9956 0.3840 

15 94.2478 3.2912 47.1239 1.6456 23.5619 0.8228 11.7810 0.4114 

16 100.5310 3.5106 50.2655 1.7553 25.1327 0.8777 12.5664 0.4388 

17 106.8142 3.7300 53.4071 1.8650 26.7035 0.9325 13.3518 0.4663 

18 113.0973 3.9494 56.5487 1.9747 28.2743 0.9874 14.1372 0.4937 

19 119.3805 4.1689 59.6903 2.0844 29.8451 1.0422 14.9226 0.5211 

20 125.6637 4.3883 62.8319 2.1941 31.4159 1.0971 15.7080 0.5485 

21 131.9469 4.6077 65.9734 2.3038 32.9867 1.1519 16.4934 0.5760 

22 138.2301 4.8271 69.1150 2.4136 34.5575 1.2068 17.2788 0.6034 

23 144.5133 5.0465 72.2566 2.5233 36.1283 1.2616 18.0642 0.6308 

24 150.7964 5.2659 75.3982 2.6330 37.6991 1.3165 18.8496 0.6582 

25 157.0796 5.4853 78.5398 2.7427 39.2699 1.3713 19.6350 0.6857 

26 163.3628 5.7048 81.6814 2.8524 40.8407 1.4262 20.4204 0.7131 

27 169.6460 5.9242 84.8230 2.9621 42.4115 1.4810 21.2058 0.7405 

28 175.9292 6.1436 87.9646 3.0718 43.9823 1.5359 21.9911 0.7679 

29 182.2124 6.3630 91.1062 3.1815 45.5531 1.5907 22.7765 0.7954 

30 188.4956 6.5824 94.2478 3.2912 47.1239 1.6456 23.5619 0.8228 
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1 Degree Grade 

Run Rise Run Rise Run Rise Run Rise 

1 0.01746 50 0.87275 92 1.60587 134 2.33898 

5 0.08728 52 0.90766 94 1.64078 136 2.37389 

10 0.17455 54 0.94257 96 1.67569 138 2.40880 

12 0.20946 56 0.97748 98 1.71060 140 2.44371 

14 0.24437 58 1.01239 100 1.74551 142 2.47862 

16 0.27928 60 1.04730 102 1.78042 144 2.51353 

18 0.31419 62 1.08221 104 1.81533 146 2.54844 

20 0.34910 64 1.11712 106 1.85024 148 2.58335 

24 0.41892 66 1.15203 108 1.88515 150 2.61826 

26 0.45383 68 1.18694 110 1.92006 152 2.65317 

29 0.50620 70 1.22185 112 1.95497 154 2.68808 

30 0.52365 72 1.25676 114 1.98988 156 2.72299 

32 0.55856 74 1.29167 116 2.02479 158 2.75790 

34 0.59347 76 1.32658 118 2.05970 160 2.79281 

36 0.62838 78 1.36150 120 2.09461 162 2.82772 

38 0.66329 80 1.39641 122 2.12952 164 2.86263 

40 0.69820 82 1.43132 124 2.16443 166 2.89754 

42 0.73311 84 1.46623 126 2.19934 168 2.93245 

44 0.76802 86 1.50114 128 2.23425 170 2.96736 

46 0.80293 88 1.53605 130 2.26916 172 3.00227 

48 0.83784 90 1.57096 132 2.30407   

 

1 Degree Grade Curves 
Radius length Rise 1/2 Rise 1/4 Rise 1/8 Rise 

9.75 61.2611 1.0693 30.6305 0.5347 15.3153 0.2673 7.6576 0.1337 

10 62.8319 1.0967 31.4159 0.5484 15.7080 0.2742 7.8540 0.1371 

11 69.1150 1.2064 34.5575 0.6032 17.2788 0.3016 8.6394 0.1508 

12 75.3982 1.3161 37.6991 0.6580 18.8496 0.3290 9.4248 0.1645 

13 81.6814 1.4258 40.8407 0.7129 20.4204 0.3564 10.2102 0.1782 

14 87.9646 1.5354 43.9823 0.7677 21.9911 0.3839 10.9956 0.1919 

15 94.2478 1.6451 47.1239 0.8226 23.5619 0.4113 11.7810 0.2056 

16 100.5310 1.7548 50.2655 0.8774 25.1327 0.4387 12.5664 0.2193 

17 106.8142 1.8644 53.4071 0.9322 26.7035 0.4661 13.3518 0.2331 

18 113.0973 1.9741 56.5487 0.9871 28.2743 0.4935 14.1372 0.2468 

19 119.3805 2.0838 59.6903 1.0419 29.8451 0.5209 14.9226 0.2605 

20 125.6637 2.1935 62.8319 1.0967 31.4159 0.5484 15.7080 0.2742 

21 131.9469 2.3031 65.9734 1.1516 32.9867 0.5758 16.4934 0.2879 

22 138.2301 2.4128 69.1150 1.2064 34.5575 0.6032 17.2788 0.3016 
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1 Degree Grade Curves 
Radius length Rise 1/2 Rise 1/4 Rise 1/8 Rise 

23 144.5133 2.5225 72.2566 1.2612 36.1283 0.6306 18.0642 0.3153 

24 150.7964 2.6322 75.3982 1.3161 37.6991 0.6580 18.8496 0.3290 

25 157.0796 2.7418 78.5398 1.3709 39.2699 0.6855 19.6350 0.3427 

26 163.3628 2.8515 81.6814 1.4258 40.8407 0.7129 20.4204 0.3564 

27 169.6460 2.9612 84.8230 1.4806 42.4115 0.7403 21.2058 0.3701 

28 175.9292 3.0709 87.9646 1.5354 43.9823 0.7677 21.9911 0.3839 

29 182.2124 3.1805 91.1062 1.5903 45.5531 0.7951 22.7765 0.3976 

30 188.4956 3.2902 94.2478 1.6451 47.1239 0.8226 23.5619 0.4113 
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